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1. STRIPASSAY® EVALUATOR

Features
StripAssay® Evaluator is the data recording and interpretation software for 
ViennaLab StripAssay® series of genetic assays.

The software is capable of automatic analysis of future products in the ViennaLab 
StripAssay® series through simple addition of the appropriate assay definition 
file (see chapter 13).

Please check https://www.viennalab.com for a list of available assays and for 
software updates.

Demo Documents
A number of demo documents are bundled with StripAssay® Evaluator. These 
can be used to explore the features of the software.

To open a demo document, use the Open a demo document ... menu item in the 
File menu.

System Requirements
	~ Computer: PC with 1 GB RAM and a screen resolution of at least 1024x768 
pixels (1280x1024 pixels or better recommended).

	~ Operating system: Microsoft Windows 7 with Service Pack 1 or Microsoft 
Windows 10). The Microsoft .NET Framework 4.72 (or higher) must 
be installed (included on the StripAssay® Evaluator installation CD or 
available from Microsoft via Windows Update or direct download).	  
For installation, administrator privileges are required.

	~ High dpi displays: StripAssay® Evaluator (from version 2.17) is fully 
compatibility with high dpi displays, such as 4K monitors or small notebook 
screens, i.e. when display scaling in Windows is set to a value other than 
100%. Earlier version had only limited high dpi compatibility, leading to text 
and images looking blurry on high dpi screens or when a display scaling 
other than 100% was in effect. Version 2.11 or less were not compatible 
with values for display scaling other than 100%. 

https://www.viennalab.com
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	~ Scanner: TWAIN-compatible flatbed scanner (32 bit drivers) capable of at 
least 300x300 dpi optical resolution and a minimum A4 (210x297 mm2) 
scanning area. Scanners from Canon (LiDE series) are recommended.	  
Compatibility of scanners can be checked with StripAssay® 
Evaluator running in demo mode. See chapter 4 for details.	  

Many scanner drivers support a fully automatic mode requiring no user interaction. 
Such modes, however, are not suitable for manual scanning from within StripAssay® 
Evaluator. If available, please use “advanced” or “professional” modes where you can 
control scan resolution. It is also possible to scan images with your favorite scanning 
software and to later import these images into StripAssay® Evaluator using the Load 
Images function (see chapter 6 for more details about loading images). Generally it 
is recommended to mount strips onto Collectors™ and use the Auto-Scan & Analyze 
function (see chapter 6).
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2. SOFTWARE INSTALLATION

Depending on the way you have received your copy of StripAssay® Evaluator, 
you will have to take the steps outlined below. You need to be logged on as 
a member of the Administrators group to install the software and necessary 
drivers.

	~ Bundled with Hardware	  
If you have received StripAssay® Evaluator together with the necessary 
hardware (computer running Microsoft Windows and a scanner), you will 
not have to take any further installation steps. StripAssay® Evaluator will 
be ready to use, and you should find an icon to start the software on the 
Windows desktop. Skip ahead to chapter 3.

	~ Received via Email or Download	  
If you have received the software by email or download, it will likely be 
in the form of a single file named EvaluatorSetup.exe (it may be packaged 
in a ZIP archive; in this case, you will have to unzip the file first). To install 
the software, simply doubleclick EvaluatorSetup.exe. In case the Microsoft 
.NET Framework has not been installed, you will be notified by the setup 
program and the installation will halt. You then first have to install the 
Microsoft .NET Framework 4.7.2 (or higher), which can be done by running 
Windows Update, or by directly downloading the .NET Framework from 
https://www.microsoft.com/downloads (search for “.NET 4.7.2”).

	~ CD or DVD	  
If you have received StripAssay® Evaluator on a CD-ROM, put the CD into 
the computer’s optical drive. The setup program should start automatically 
(if it does not, double-click EvaluatorSetup.exe in the root directory of the 
CD. Follow the instructions presented by the setup program. The Microsoft 
.NET Framework 4.7.2 is included on the CD in several different languages. 
Should a version corresponding to the language version of your Windows 
operating system be missing, it is recommended that you download and 
install the appropriate language version manually instead (see above).

https://www.microsoft.com/downloads
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	~ Deinstallation	  
To uninstall StripAssay® Evaluator, please follow the steps outlined in 
chapter 14.

	~ Full and Limited Versions	  
StripAssay® Evaluator operates in full or limited mode depending on whether 
a so called “dongle” is plugged into one of the computer’s USB ports. Data 
acquisition is disabled in the limited mode (without dongle), i.e. you cannot 
load or scan new images. However, it is possible to analyze and annotate 
strips and to print reports even in limited mode. StripAssay® Evaluator can 
be installed and unsed on any number of computers, but image acquisition 
is limited to the computer with the dongle.

To obtain a dongle, please contact your local ViennaLab distributor or ViennaLab 
Diagnostics GmbH directly.

https://www.viennalab.com
https://www.viennalab.com


	 3. Navigating the Software

ViennaLab StripAssay® Evaluator	 – 5 –

3. NAVIGATING THE SOFTWARE

StripAssay® Evaluator organizes the analysis workflow in four steps, easily 
accessible via the main nagivation bar. Clicking on a tab will show a screen 
associated with the specific steps and tasks.

	Start / Acquisition
When starting a new analysis, general information about the assay is specified, 
such as assigning an ID to the assay document, naming the operator, filling in 
the assay lot number, the date, and any comments. When images of strips will 
not be scanned from Collectors™, the type of assay should be selected as well.

The data aquisition wizard shown on the right half of the screen will guide you 
through the image acquisition process (see chapter 5 and chapter 6 for more 
details).

	Strips / Sample Info
After images have been acquired, this screen allows to verify the correct 
placement of strips on the scanned images after automatic detection and to 
make necessary adjustments (or to manually place strips). Furthermore, the 
scanned images, named “sheets”, can be rotated, cropped, or exported via the 
tools accessible on this screen. For more details, see chapter 7.

The sample info panel shown on the right side of this screen provides the 
opportunity to assign sample IDs (patient names, dates of birth, remarks) to 
individual strips as well as to whole sheets. See chapter 8 for more details on 
this topic.

	Results
The results screen shows an individual strip and the interpretation of its 
staining pattern, as well as present options to modify the recognized pattern, 
if necessary, and to edit the sample information associated with the particular 
strip. Exporting and printing of a single strip is also possible from this screen. For 
more details, see chapter 9.
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	Reporting
Finally, after strip results have been validated by the responsible assay operator/
analyst/physician, the results can be printed in the form of either a summary 
report or as detailed reports for each sample. Results can also be exported to a 
file that then can be imported into e.g. Excel. For more details on reporting see 
chapter 10, and for an overview of export options, see chapter 11.

See chapter 16 for a complete menu and button reference.
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4. PROGRAM SETTINGS

When the software is started for the first time, or by going to Tools‑>Program 
Settings, the Program Settings dialog is shown.

	Folder Locations
Here, you can change the default storage locations for assay documents (.sad2 
files) and templates (.sat2 files). The defaults have been set during program 
installation and are subfolders in your usual documents folder.

	Scanner Selection
This item shows the currently selected scanner. To set or change the scanner 
that should be used by the software, click on the search button and select a 
scanner from the list. The scanner needs to be TWAIN-compatible (WIA drivers 
will not give satisfactory results). If you receive an error message stating that no 
TWAIN scanners are installed when you try to select a scanner, make sure that 
the scanner driver that was included with your scanner (or downloaded from 
the scanner manufacturer’s homepage) has been properly installed, and double 
check that the scanner driver adheres to the TWAIN standard.
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	Scanner Calibration
It is also indicated whether the selected scanner has been calibrated. To calibrate 
a scanner, click the Calibrate button and follow the instructions shown on the 
screen. Calibration only needs to be done once per scanner.

To perform scanner calibration, click the Start Calibration button (). Status 
messages and a progress bar will keep you informed about the process ().

	Scanner Compatibility Check
Compatibility of a scanner or scanner driver with StripAssay® Evaluator can 
be verified by running a scanner compatibility test. To run this test, click the 
Compatibility Check button. This will show the Scanner Compatibility dialog. 
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To start the compatibility check, first place the Scanner Compatibility Check Sheet 
in the scanner. The Scanner Compatibility Check Sheet can be printed from a PDF 
which can be accessed by clicking button  (this requires Adobe Acrobat or 
another PDF reader to be installed). Then, click the Start Check button () to 
initiate the test scan. The result of the test will be displayed in the status area 
() and a more detailed report that can be displayed in a Web browser will be 
saved to the Desktop. 

	Default Import / Export Filters
Here, you can set which import/export filters should be used for importing and 
exporting sample information data, and for exporting results. In a standard 
installation of StripAssay® Evaluator, only one filter per category is installed. 
Please contact ViennaLab Diagnostics GmbH if you require specialized export 
capabilities and ask for a quote.

	System Settings
Use Display Scaling to set the Windows display scaling value for the screen 
you are running StripAssay® Evaluator. Usually, this value does not need to be 
adjusted. If you notice display problems, especially regarding the display of the 
strip schematics, check that this value corresponds to the Windows settings 
(Windows Settings / System / Display). 

https://www.viennalab.com
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5. PREPARATIONS (START)

To process strips with StripAssay® Evaluator, please follow the procedure 
outlined below.

Mounting of Strips
Place each processed strip onto one of the designated fields () on the 
appropriate Collector™ (supplied with the StripAssay® kit), align it with the 
schematic drawing using the red (top) and green/blue (bottom) marker lines, 
and fix it to the sheet with adhesive tape. Alternatively, any other support can 
be used, but automatic scanning and processing will not be possible then.

Assay Setup
If it is not already displayed, switch to the Start / Acquisition screen. If another 
assay document is still open, start a new assay by clicking File‑>New (or File‑>New 
From Template if you want to reuse assay information stored in another assay 
document or template file).

Make sure not to cover any marker or hybridization positions with the tape, as this 
might interfere with scanning. Also take care not to obscure the barcode () area 
since otherwise the automatic detection of the assay type might not be possible.
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Before scanning of the strips some information about the assay should be 
recorded in the appropriate fields:

 Enter an assay ID. The program automatically suggests a name based on the 
current date and time. You might want to put an assay ID consistent with the 
policy of your lab here. Also, set the date of the assay, and enter an operator 
ID, i.e. a reference to the person who performed the analysis.

 Specify the lot number of the kit used.

 Enter any additional comments if desired.

Define the StripAssay® Type
When the strips are mounted on a Collector™ with a barcode, this step is not 
necessary, as the assay type will be determined automatically.

When you plan to scan manually, or load a pre-existing image for analysis, the 
type of assay should be specified before starting with the image acquisition. To 
select a StripAssay® type, click the Change Assay button (), and select an assay 
type from the list (for more information on the StripAssay® Selector, see chapter 
13).
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Preparing to Scan
Place the Collector™ onto the scan area of the scanner in such a way that the 
arrow in the lower left corner of the sheet ( in the image on the previous 
page) points towards the scanner’s scan origin. The corner of the sheet should 
touch the corner of the scan surface. The scan origin usually is the front left or 
rear right corner of the scanner when the lid opens away from you.

Continue to chapter 6 for more details on the image acquisition process.

To empirically determine where the scan origin is located, simply place a Collector™ 
(or any other suitably marked piece of paper) into the scanner in one of the positions 
mentioned earlier. Then, perform a manual scan using StripAssay® Evaluator (or any 
other scanning software). The sheet is inserted correctly when the arrow (or marking) 
appears in the upper left corner of the scanned image.

IMPORTANT
Please make sure that the strips mounted on a Collector™ (or any other support) 
are lying flat on the scanner’s surface and that the lid is closed securely. Failure to 
ensure this might lead to uneven scan results and potential misinterpretation of 
assay results..
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6. DATA ACQUISITION

After the necessary preparations have been completed (see chapter 5), the 
next step is to scan the strips (or to load an existing image). The Acquisition 
Wizard () shown on the Start / Acquisition screen will guide you through the 
acquisition process. The options presented by the wizard will depend on the 
state of the current assay document.

Two basic modes of operation are possible, Automatic Mode (Auto-Scan & 
Analyze, ) and Manual Mode ().The mode will be locked after the 
acquisition of the first image. For routine scanning of strips mounted on 
Collectors™, the automatic mode is most appropriate. In the manual mode, 
sheet images are obtained either by loading pre-existing images from disk (Load 
Image, ) or by scanning (Scan Image, ).

The aquisition options will be limited, depending on whether images already exist in 
the current assay document, and how the first image was acquired. For example, if 
a Collector™ was scanned, the options are limited to scanning further Collectors™ of 
the same type.

The options to acquire images from a scanner (automatic or manual mode) is only 
available when a scanner has been chosen in Program Settings (see chapter 4).
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Automatic Mode
Click on Auto Scan & Analyze to start automatic scanning and analysis of strips 
mounted on a Collector™. Follow the instructions of the wizard. Unless you have 
put a checkmark into Ignore Barcode (), the software will read the barcode from 
the Collector™ to determine the type of assay. Otherwise, it will be assumed that 
a Collector™ matching the current assay type has been placed into the scanner. 
Click the Auto-Scan & Analyze () button to start the scanning process.

Before scanning Collectors™, it is important to calibrate your scanner (see chapter 4).

Some scanner drivers support a “full-auto” mode where no user intervention is 
required. Such a mode is not suitable for manual scanning from within StripAssay® 
Evaluator. Please set the scanner software to run in a mode that allows user 
intervention, i.e. the manual setting of scan parameters such as resolution, color 
depth, and image processing. Alternatively, you can scan images with your favorite 
scanning software and later import these images via Load Image.
For best results, a scan resolution of 300 dpi and a color depth of 24 bits per pixel is 
recommended. Also, disable any color correction or image processing options such as 
“unsharp mask”.

StripAssay® Evaluator supports images in these formats: TIFF (*.tif), JPEG (*.jpg, 
*.jpeg), GIF (*.gif), Portable Network Graphics (*.png), and Windows Bitmap (*.bmp).



	 6. Data Acquisition

ViennaLab StripAssay® Evaluator	 – 15 –

After the barcode has been correctly interpreted, the software will extract the 
area containing the strips and start the automatic detection process. If reading 
of the barcode failed, you will be prompted to set the type of assay manually. 
When scanning and detection are completed, you will be informed about the 
number of detected strips and presented with the option to either scan more 
sheets, or to continue to the Strips / Sample Info screen or to the Results screen.

Manual Mode
Image acquisition in manual mode can be done by scanning images manually, 
using the interface provided by the scanner driver, or by loading existing images 
from disk. After loading or scanning a sheet, you will be prompted to enter 
some information about the sheet () and whether to just add the sheet to the 
assay or to attempt automatic detection of strips (), to add the sheet without 
automatic detection (), or to not add the sheet ().

Removing Sheets
Sheets can be removed from an assay document via the Sheet->Delete menu on 
the Strips / Sample Info screen. See chapter 7 for more information.

Subsequent Collectors™ in a multi-sheet assay must be of the same type, as different 
types of strips within one assay document are not allowed.

Automatic detection is only available for single-strip assays.
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7. MANIPULATING STRIPS

On the Strips / Sample Info screen you can verify the placement of strips after 
auto-detection. Furthermore, you can add, re-position, or delete strips manually 
on scanned images. Additionally, especially when using loaded or manually 
scanned images, you can perform a number of image manipulations such as 
rotating or cropping.

The main options on the Strips / Sample Info screen are:

	 Manipulate strips: Re-position, add, or delete strips.

	 Navigate between strips: Use the menu to jump directly to a specfic strip (a 
similar menu is available for sheets when there are two or more sheets in an 
assay document).

	 Edit sample information: Change the default name of strips, add patient data 
(name, date of birth), as well as any comments and remarks.

	 Edit sheet information: You can name sheets and add comments.
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Toolbar Options

	 Navigate between sheets. Either select a specific sheet from the menu, or 
use the arrow buttons to navigate to the previous (left) or next (right) sheet.

	 Navigate between strips. Either select a specific strip from the menu, or use 
the arrow buttons to navigate to the previous (left) or next (right) sheet.	  

	 Add, delete, renumber, and detect strips:

	~ Click the Add a new Strip menu (or click the corresponding toolbar 
button) to add a new strip to the sheet. The frame for the new strip is 
initially displayed in the top left corner of the sheet area, and is labeled 
with the next available number.					      
If a Collector™ was scanned, strips can only be added as long as 
unoccupied positions are available; when a new strip is added to a 
Collector™, the Strip Position dialog is displayed and you have to assign 
a position number.

You can also use the PageUp and PageDown keys on your keyboard to navigate 
between sheets, and the < and > (left and right arrow) keys to navigate between 
strips.

Strips can also be added by 
pressing the A key. In this case, the 
new strip is added to the sheet at 
the position of the mouse cursor.
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	~ Click the Delete Strip menu (or click the corresponding toolbar button) 
to delete the currently selected strip. The remaining strips will be 
renumbered, starting with 1. In Collector™ mode, no renumbering will 
occur when strips are deleted. The keyboard shortcut is Del.

	~ Click the Renumber menu to swap 
the numbers of two strips () or to 
renumber all strips on the sheet (). 
Numbering will start with 1 and proceed 
from top left to bottom right. This option 
is not available in Collector™ mode.

	~ Click the Auto-Detection menu (or the corresponding toolbar button) 
to attempt an automatic detection of strips. This will remove any strips 
already present on the sheet. This option is not available in Collector™ 
mode or for multi-strip assays.

	 Manipulate sheets:

	~ Rotate sheets clockwise (CW) or counterclockwise (CCW). Existing strips 
will be rotated with the sheet.

	~ Flip (mirror) sheets horizontally or vertically. Existing strips will be 
transformed accordingly.

	~ Crop sheets. First, draw a cropping rectangle () on the sheet (hold 
down the left mousebutton while moving the mouse). Then, press the 
Crop menu item () to remove everything but the marked area.

All strips on the sheet will be removed! This cannot be undone.
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	~ Swap the current sheet with the previous or next.

	~ Delete the current sheet.

	~ Save the current sheet as an image file. You will be prompted to choose 
a save location and file name. The image can be saved in the TIFF, JPEG, 
or BMP format.

	 Adjust the zoom. You can adjust the magnification/
reduction with which the sheet image is displayed 
zoom controls on the toolbar, or select a predefined 
magnification from the zoom menu. The Magnifying 
Glass settings allow control of display of a “magnifying 
glass” while dragging the top or bottom marker 
hotspots (see image below). When checked, top 
or bottom marker magnifiers are always displayed, 
otherwise they are only visible when hotspots (see below) are dragged with 
the right mousebutton.

	 Toggle display of the sample info area. Click the toolbar button to show or 
hide the sample and sheet info area on the right side of the Strips / Sample 
Info screen.

Positioning Strips
To position strips, first select the strip to be manipulated (either by 
clicking on it or by selecting it from the strip selection menu). The 
active strip and its number will be highlighted with a yellow frame 
(). When the mouse is moved over the selected strip, the cursor 
will change to a hand. The strip can now be moved on the sheet by 
dragging it while holding down the left mousebutton (for example, 
the hotspot marked ). Two special hotspots exist on a strip, top 
() and bottom () markers, marked by triangles pointing towards 
the strip outline. When the mouse is positioned in these hotspots, 
a crosshair cursor is displayed. Dragging the topmarker will move 
the strip (equivalent to dragging with the hand cursor), unless the 
top marker magnifier is enabled (see above) or dragging is done 

All strips on the sheet will be removed! This cannot be undone.
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with the right mousebutton. In these cases, the region around the marker is 
magnified, facilitating propper positioning of a strip (see above). Dragging the 
bottom marker hotspot will result in the rotation of the strip and, within certain 
limits, the adjustment of the strip’s length.

Strips can be easily positioned with the help of keyboard shortcuts. Pressing T will 
move the active strip’s top marker hotspot to the position of the mouse cursor. B will 
move the bottom maker (if the mouse is in a valid distance from the top position).
Pressing A adds a new strip at the current mouse position.
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8. EDITING SAMPLE INFORMATION

Sample information, including sample id (), patient name () and date of 
birth (), as well as additional notes (), can be conveniently edited for each 
strip in the assay using the corresponding fields found on these screens:

	~ Strips / Sample Info (see chapter 7),

	~ Results (see chapter 9), and

	~ Reporting (see chapter 10).

The example shown is from the Results screen.

Any changes to the sample information apply in real-time 
(i.e. the selection menus will be updated immediately).

The sample info panels on the Results and Reporting screens 
additionally allow to set whether a strip should be included 
in the detailed and/or summary reports (). See chapter 
10 for more details on reporting.

Importing/Exporting Sample Information
On the Reporting screen, additional options to manipulate sample information, 
including importing and exporting, can be found:

	 The sample information (id, patient name and date of birth, and notes) of 
the active strip () can be cut, copied, or pasted.

	 Clicking the Export or Import menu items, sample info data can be exported 
or imported, respectively. See below for a detailed description of the data 
format of the build-in import/export filter.

	 To choose how sample info data 
is handled, click the Import/Export 
Filters menu item. This will pop up 
the Program Settings dialog where 
you can select the filters (see chapter 
4).
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Basic Import/Export Filter – Specification
The built-in standard filter for sample information reads and writes a simple 
tab-delimited text file with six columns. Empty lines and lines starting with “#” 
are ignored.

1 Sheet Number
2 Strip Number
3 Sample (Strip) ID
4 Patient Name
5 Patient Date of Birth
6 Comments / Notes

Example (Export):

# SheetNo StripNo SampleID  PatientID          Date of Birth  Notes

# Sheet -1- Test Sheet #1

1         1       Strip 1   Neg. Control                      water as PCR template

1         2       JD123     John Doe           1972-12-09

1         3       Strip 3                                     high background

1         4       Strip 4   Synthetic Sample    

1         5       Strip 5

1         6       Strip 6

Sheets and strips have to be numbered consecutively, beginning with 1.
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9. RESULTS

The Results screen shows detailed information about individual strips. You 
should view and validate each result before including a strip in a report.

The screen is divided in three panels:

	 The strip panel, where individual strips are shown in detail, with a schematic 
representation of the strip on the left side, labels on the far right, and in the 
middle the scanned image of the strip aligned with the schematic drawing as 
well as a curve roughly corresponding to staining intensities.

 	The result panel, where the interpretation of the strip’s pattern (negative/
positive positions) is shown as summary and detail results. Any warning 
or error messages are also shown here.				     
When positions, or related groups of positions, fail to evaluate (e.g. when 
corresponding mutant and wild-type positions are both negative), the 
respective positions will be marked with an exclamation mark in a yellow 
triangle. Inspect these positions carefully and, if warranted, correct one of 
the positions involved. Any changes will be reflected in the result immediately 
(see below for information on how to modify positions).



	 9. Results

ViennaLab StripAssay® Evaluator	 – 24 –

	 The sample information panel, which can be used to enter additional 
information, such as the id of the sample/patient the strip is corresponding 
to. See chapter 8 for more information on editing sample information.

Editing the Strip Pattern
Based on staining intensities and other criteria (e.g. peak shape), the software 
determines whether a specific position on the strip should be regarded as 
positive or negative. The result of this assessment is presented by blue (positive) 
and light gray (negative) positions in the schematic drawing of the strip.

To change the state (positive or negative) of a position, do this:

	~ Move the mouse cursor over the respective position (the cursor will change 
to a hand symbol).

	~ Click the position with the left mousebutton to mark it as positive.

	~ Click the position with the right mousebutton to mark it as negative.

Moving the cursor over positions while holding a mousebutton pressed will 
mark all positions moved over. The changes will be reflected in the results 
immediately.

Once the interpretation of the strip has been validated by a responsible person, 
include the strip in one or both of the report types by checking the corresponding 
checkboxes.

To undo/reset any user modifications, press either the Remove user modifications 
button or the Re-evaluate strip button on the toolbar (see below).

You, the user, can override the decisions made by the software. However, whenever 
modifications are made by the user that differ from the automatic evaluation, the 
strip will be marked as “user-modified”. This is indicated in the results panel and on 
all reports. Modified positions are highlighted (orange frame) in the strip schematic.
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Toolbar Options

	 Navigate between sheets by clicking the left/right arrow buttons, or by 
selecting a sheet from the dropdown menu. Keyboard shortcuts: PageUp, 
PageDown.

	 Navigate between strips on a sheet by clicking the left/right arrow buttons, 
or by selecting a strip from the dropdown menu. Keyboard shortcuts: <, >.

	 Delete the current strip. Keyboard shortcut: Del.

	 Zoom the strip view (in, out, and fitting the available space).

	 Remove user modifications.

	 Re-evaluate the strip. The dropdown menu gives the option to re-evaluate 
all strips on the current sheet.

	 Export the results:

	~ Copy Result Text will copy the results to the clipboard in text form.

	~ Save Schematic will save the content of the strip view as Metafile (EMF, 
vector graphics) or TIFF (pixel graphics) file.

	~ Copy Schematic will copy the content of the strip view to the clipboard 
(Metafile format).

	 Print or preview a detailed report for this strip (see chapter 10 for more 
details on reporting).

	 Toggle the display of the sample information panel (see chapter 8 for more 
details on managing sample information).
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10. REPORTING

The Reporting screen summarizes the results of all strips and lets you print 
and export detailed and summary reports. Additionally, it provides enhanced 
sample information management tools (see chapter 8 for more information on 
this aspect).

The main elements of the Reporting screen are:

	 The Sheets & Strips panel lists all strips, ordered by sheets. Left-click a sheet 
or strip entry to select it. Panel  will update accordingly. Right-clicking will 
show a popup menu (see below).

	 The Details panel shows detailed information for the selected sheet or strip.

	 The Detailed Reports panel lets you print and preview detailed reports. The 
number of strips that are marked for inclusion in this type of reporting is 
indicated.

	 The Summary Report panel lets you print, preview, as well as export 
summary reports. The number of strips that are marked for inclusion in this 
type of reporting is indicated.					      
Strips marked for inclusion in a summary report will be exported when 
clicking the Export button. For more detailed information on data export, 
please see chapter 11.
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Inclusion or exclusion of individual strips in the respective report types (detailed, 
summary) is controlled via the detailed and summary report icons ().

To toggle between inclusion and exclusion, either double-click the respective 
icons for each strip in the list (), or double click the icons above the list to 
include or exclude all strips (). Alternatively, the corresponding checkboxes 
can be set in the Details view for each strip ().

Context Menu

Depending on whether the list entry for a sheet or strip is right-clicked, a 
corresponding context menu will pop up, with these options:

	 Include or exclude all strips on the selected sheet in/from detailed reporting.

	 Include or exclude all strips on the selected sheet in/from summary reporting 
(results data exporting).

	 Cut, copy, paste sample information. See chapter 8 for more details on 
sample info management.

	 Include or exclude the selected strip in/from detailed reporting.

	 Print or preview a detailed report for the selected strip.

	 Include or exclude the selected strip in/from summary reporting (results 
data exporting).

Inclusion/exclusion of strips for reporting can also be set on the Results screen (see 
chapter 9).
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Reporting Toolbar

	 Navigate between sheets.

	 Clear the sample info for all strips on the currently selected sheet.

	 Sample info management options. Please see chapter 8 for more information 
on this topic.

	 Here, you can customize certain aspects of printed detailed and summary 
reports (see below). Choose Export Filter will open the Program Settings dialog 
(see also chapter 4) where an export filter can be selected that will be used 
when the Export button is clicked (see chapter 11 for more information on 
data export).

Previewing Reports
The Print Preview dialog displays 
reports as they would appear on 
paper. Using the toolbar, the reports 
can be printed (), the zoom level 
can be changed (), and multi-page 
reports can be navigated ().

Paper size and orientation can be set 
in the Page Setup dialog, accessible via 
the File menu.
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Customizing Report Styles
The Report Settings dialog allows to customize the way reports are printed.

	 In the Common - Page Header panel, a header line can be entered which will 
be printed at the top of each report (detailed and summary) if the Show 
Header checkbox is checked. If desired, a graphical banner can be loaded with 
the Load Banner button. It will be displayed at the top of each printed page 
if the Show Banner checkbox is checked. The banner image will be stretched 
across the full width of the page, so it should be designed accordingly.

	 In the Summary Reports panel, the report generation engine can be selected 
that is used to generate the summary reports. A page footer line can be 
specified which will be printed at the bottom of each page if the Show Footer 
checkbox is checked. The page margins can also be set specifically for this 
report type.

	 In the Detailed Reports panel, the report generation engine can be selected 
that is used to generate the summary reports. A page footer line can be 
specified which will be printed at the bottom of each page if the Show Footer 
checkbox is checked. The page margins can also be set specifically for this 
report type.
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Formatting Parameters
A set of formatting parameters and placeholders can be used in the header and 
footer lines of reports.

Alignment of text portions can be achieved with the modifiers {L} (left), {C} 
(center), and {R} (right). These cause subsequent text to be aligned accordingly 
(left alignment is the default if no alignment is specified).

Usable placeholders are:

	~ %d — current date.

	~ %t — current time.

	~ %p — page number within an individual report.

The placeholders can be used anywhere in a header or footer line and will be 
substituted with the respective values at the time of printing.

Example:

{L}Institution{C}-%p-{R}%d

This will result in a line of text with “Institution” printed at the left, the page 
number between dashes in the middle, and the current date at the right.

The aligment modifiers must occur in the order L C R and each can appear only once.
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11. DATA EXPORT

Various data can be exported from StripAssay® Evaluator in different contexts:

Results of a Single Strip
The result of a single strip can be copied to the clipboard as plain text using the 
Copy Result Text menu item in the Export menu on the Results screen. See also 
chapter 9.

Strip Images and Schematics
An individual strip as presented on the Results screen can be exported either 
to the clipboard in the Windows Metafile format, or saved to disk (Windows 
Metafile or TIFF) directly from the Results screen using the options in the Export 
toolbar menu. See also chapter 9.

Sheet Images
Scanned sheets can be saved as TIFF, JPEG, or BMP images from the Strips / 
Sample Info screen. Browse to the sheet to be saved and click Save Sheet Image 
in the Sheet toolbar menu. See also chapter 7.

Assay Results
To export genotype results (and sample info data), go to the Reporting screen 
and follow these steps (see also chapter 10):

	~ Optionally, first select a results export filter in the Program Settings dialog 
(accessible via the Tools menu or from the Reporting screen toolbar).

	~ Next, mark the strips to be exported for inclusion in the summary report.

	~ Finally, click the Export button.

The following result export filters are built into StripAssay® Evaluator:

Basic Results Exporter
This filter will produce a text file containing general assay information as well 
as sheet/strip data in a tab-delimited format that can be opened with programs 
such as Microsoft Excel.
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At the top of the file, basic assay information is written in a two-column format, 
followed by condensed strip results (6 columns: SampleID, PatientID, PatientDOB, 
Notes, Results Summary, Profile). In subsequent columns (the number depends 
on the specific assay type), the detailed results for each result group are written. 
The final two columns are Warnings and Errors.

Use of the Basic Results Exporter is deprecated. For new export setups, use of the 
Extended Results Exporter is recommended.

Extended Results Exporter
This filter can be configured to export results data, optionally including image 
data, in a variety of formats to either a file folder or to a web service.

To configure the filter, go to Program 
Settings and click the button to open the 
Select Plugin dialog (see chapter 4 for 
details). Here, choose Extended Results 
Exporter from the list of available plugins 
() and click Set Plugin Options () to 
open the Plugin Settings dialog.

In the Plugin Settings dialog, use the Mode, Destination, and CSV tabs to configure 
the export plugin to your needs.

	 Set the data format: CSV produces a text file containing the data in a tabular 
format, similar to what the Basic Results Exporter produces (see above). 
CSV is limited to a folder destination and images cannot be embedded. 
Additional CSV settings such as the type of delimiter and the file extension 
can be chosen on the CSV tab.

	 JSON formats the exported data in the JavaScript Object Notation format. 
JSON data can be exported to a file or sent to a web service via POST. Images 
can optionally be embedded.
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	 When set to XML, the output format will be extensible markup language 
which can be saved to a file or uploaded to a web service, with or without 
embedded image data.

	Choose to include image data: Here you can choose whether image data 
(i.e. individual strips as displayed on the Results screen) should be included 
in the export. Embedding is optional for JSON and XML file exports. This 
setting is ignored when the output format is CSV, where images are never 
embedded. Image data is always embedded for web service uploads. When 
image data is embedded, it is base64-encoded. Images can be either in the 
TIFF or JPEG format (with .tif and .jpg extensions when saved to a folder). 
The image resolution can be set from 72 dpi up to 600 dpi. When the image 
format is JPEG, the quality setting is obeyed (lower settings result is smaller 
output size).

	 Choose the export destination: Save to directory allows to save all data 
formats as files. The default directory can be set. File names are generated 
automatically unless the Prompt for filename option is checked.

	 Upload via POST directs the export (JSON or XML format only) to a web 
service. The address of the web service must be entered in the textbox. When 
multiple records (strips) are exported, these can be uploaded individually 
(One per POST) or as a single upload (Combined). Optionally, headers can be 
set which are included in the POST request (e.g. for access tokens).

	 Tailor CSV exports: Here you can choose how data fields in CSV files are 
separated either by tab, comma, semicolon, or pipe (|), and what file 
extension the export file should have.
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The details of the CSV, JSON, and XML data structures that are produced by the 
Extended Results Exporter are beyond the scope of this manual. However, the 
specific structures can easily be deduced from exports in the respective formats.

Please contact a member of your IT department responsible for data integration 
to assist you.
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12. STRIP CALCULATOR

The Strip Calculator provides a means to evaluate patterns on strips without 
having to scan a physical strip. It can be activated by clicking the Calculator 
button on the main toolbar, the Start / Acquisition screen, the StripAssay Selector 
dialog, or from the Tools menu.

The window is divided into two panels, a schematic strip on the left () and the 
corresponding result on the right side ().

Initially, all positions on the strip are set to their default states, corresponding 
to a typical normal result. To alter the state of a position, click it with the left 
mousebutton to make it positive, or with the right mousebutton to make it 
negative. Any changes in the Strip panel are immediately reflected in the Result 
panel.
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Toolbar Options

	 Click the assay name to show the StripAssay Selector dialog (see chapter 13) 
in order to select a different assay type.

	 Use the zoom controls to adjust the display of the strip.

	 Click to copy the strip schematic shown in the Strip panel to the clipboard 
(Windows Metafile format).

	 Click to copy the text in the Result panel to the clipboard.
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13. STRIPASSAY SELECTOR

The StripAssay Selector dialog is used to:

	~ Display the list of installed assay definitions.

	~ Select an assay type to work with.

	~ Manage assay definition files.

The dialog consists of three panels, that show the list of available assay 
definitions (), details about the currently highlighted assay definition (), 
and a preview of the strip(s) defined in the currently highlighted assay definition 
().

Toolbar Options
	 Use the View menu to control how 

the available assay definitions 
are displayed (as detailed list or 
simple icons) and sorted (by name 
or catalog number).

	 Click the Manage button to toggle management mode on or off (see below).

	 Click the Calculator button to display the Strip Calculator window pre-loaded 
with the currently highlighted assay definition.

	 Click the Preview Strip button to toggle the display of the Preview panel.
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Assay Definition Management

Use the management mode to choose which assay definition are displayed in 
regular mode by checking (displayed) or unchecking (hidden) the corresponding 
checkbox (), or by using the popup menu () that opens when an assay 
definition is right-clicked.

The External Assays menu () allows you to import additional assay definitions. 
Only imported (“external”), but not built-in assay definitions can be deleted.
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14. SOFTWARE DEINSTALLATION

To uninstall StripAssay® Evaluator from your computer, start the uninstall 
program that was installed with the software. You can find it at Start‑>All 
Programs‑>StripAssay Evaluator‑>Uninstall.

Alternatively, go to Start‑>Control Panel‑>Add or Remove Programs. Locate the 
entry for StripAssay® Evaluator and click on Remove.

Follow the instructions presented by the uninstall program.
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15. TROUBLESHOOTING & SUPPORT

Software/Hardware-related Problems
	~ Software Installation

	~ StripAssay® Evaluator must be installed using an administrator account. 
If you cannot run the installer with administrator privileges, please 
contact your system administrator.

	~ If your system does not currently have the Microsoft .NET Framework 
4.7.2 installed, and the language of your installation of Windows is 
not listed in the language selection dialog that appears when you first 
run the installation program, it is advisable to download and install a 
version of the Microsoft .NET Framework 4.7.2 matching your language 
version of Windows rather than to install one of the version included 
on the installer CD. Microsoft .NET Framework can be downloaded 
directly from Microsoft (go to https://www.microsoft.com and search 
for “Framework 4.7.2 Redistributable”).

	~ No assay definitions available

	~ Open the StripAssay Selector dialog, activate management mode, 
and check whether maybe all assay definition have been hidden (see 
chapter 13).

	~ Re-install StripAssay® Evaluator and make sure that at least one assay 
definitions is checked for installation.

	~ Import/Export does not work (buttons are disabled)

	~ Open the Program Settings and/or Report Settings dialogs and verify 
that plugins are selected. If no plugins are available, please re-install 
StripAssay® Evaluator.

	~ Scanning does not work

	~ Open the Program Settings dialog and verify that the Scanner section 
shows the name of a scanner that is installed on the system and that 
this scanner is connected to the computer and turned on.

https://www.microsoft.com
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	~ Install an updated version of the scanner driver. The scanner driver 
must provide a TWAIN-compatible interface.

	~ Make sure the scanner driver does not operate in a “Full‑Auto” or 
“Wizard” mode. Set it to “Advanced” or “Professional” mode (please 
consult the documentation of your scanner).

If you cannot solve the problem by yourself, please follow these steps:

	~ Record the problem and the steps leading to the problem as detailed as 
possible.

	~ If StripAssay® Evaluator displayed an error message, record it with all details 
(make a screenshot and copy/paste additional information.

With the gathered information, please contact the technical support department 
of ViennaLab Diagnostics GmbH by email (techhelp@viennalab.com).

Analysis-related Problems
In case of problems with the interpretation of a strip, submit a Problem Report, 
accessible via the Help menu (if this menu items is not available, please contact 
your local ViennaLab distributor or ViennaLab Diagnostics GmbH directly).

Please follow these steps:

	 Enter your details (name, email address, 
lab name).

	 Give a detailed description of what the 
problem is.

	 Optionally, check to include the currently 
open assay document.

	 Click the Send Email button.

Sending a problem report requires that a MAPI-enabled email program such as 
Microsoft Outlook or Outlook Express is installed on the computer running StripAssay® 
Evaluator, and that an active internet connection is available!

mailto:techhelp%40viennalab.com?subject=StripAssay%20Evaluator
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16. MENU / TOOLBAR REFERENCE

File Menu

New – Starts a new assay.

New from template … – Starts a new assay based on settings/information 
contained in an assay template (.sat2) or assay document (.sad2) file.

Open … – Opens a previously saved assay document file (extension .sad2).

Open a demo document … – Opens the folder with the demo documents.

Save – Saves an assay document to disk.

Save As … – Saves an assay document file (.sad2) to disk under a new name.

Save as template … – Saves the current assay as a template file (.sat2).

Page Setup … – Opens the Page Setup dialog.

Exit – Quits StripAssay® Evaluator.

Edit Menu

Cut – Copies the selected text into the clipboard and removes it.

Copy – Copies the selected text into the clipboard.

Paste – Pastes text from the clipboard into the active textbox.
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Assay Menu

Assay Setup … – Shows the Start / Acquisition screen. See chapter 5 for more 
information.

Auto-scan Collector™ … – Shows the Start / Acquisition screen and initiates 
automatic scanning of a Collector™. See chapter 6 for more information.

Manual Scanning … – Shows the Start / Acquisition screen and initiates manual 
scanning of a sheet. See chapter 6 for more information.

Load Image … – Shows the Start / Acquisition screen and loads an image from 
disk. See chapter 6 for more information.

Edit Strips … – Shows the Strips / Sample Info screen. See chapter 7 for more 
information.

Browse Results … – Shows the Results screen. See chapter 9 for more details.

Reporting – Shows the Reporting screen. See chapter 10 for more information.

Tools Menu

Strip Calculator – Opens the Strip Calculator window. See chapter 12 for more 
information.

Program Settings … – Displays the Program Settings dialog. See chapter 4 for more 
information.
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Customize Report … – Displays the Report Settings dialog. See chapter 10 for more 
information.

Change Language – Shows the Change Language dialog. Changes will take effect 
after a restart of the software.

Help Menu

Online Help … – Displays the online help.

Problem Report … – Opens the Problem Report dialog. See chapter 15 for details. 
This menu may be unavailable.

Technical Support Homepage – Opens a browser window. This menu may be 
unavailable.

About StripAssay Evaluator … – Displays the splash screen with program version 
information.

Main Navigation Bar
See chapter 3 for an overview on navigating the software.

	 Shows the Start / Acquisition screen. See chapter 5 and chapter 6 for more 
information.

	 Shows the Strips / Sample Info screen. See chapter 7 for more information.

	 Shows the Results screen. See chapter 9 for more information.

	 Shows the Reporting screen. See chapter 10 for more information.
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Main Toolbar

	Starts a new assay document, loads an existing assay document, or saves the 
assay document.

	 Cut / Copy / Paste text from/into textboxes.

	 Opens the Strip Calculator window. See chapter 12 for more information.

	 Shows the online help.

	 Shows the catalog number and name of the currently active assay type.

Strips / Sample Info Toolbar
See chapter 7 for a detailed description of the toolbar buttons.

	 Navigate sheets.

	 Navigate strips.

	 Add addtional strips, delete strips, renumber strips, or start the automatic 
detection of strips.

	 Manipulate sheets.
	 Sets the zoom level of the sheet display and controls the behavior of the 

magnifying glass during strip adjustment.

	 Shows or hides the sample information panel.
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Results Toolbar
See chapter 9 for a detailed description of the toolbar buttons.

	 Navigate sheets.

	 Navigate strips.

	 Deletes the currently active strip.

	 Controls the display (zoom level) of the strip image and schematic.

	Removes any user modifications from the current strip.

	 Re-evaluates the current strip or all strips on the current sheets.

	 Copies the current result text or strip image (including the schematic) to the 
clipboard and/or saves the currently displayed strip to a Windows Metafile.

	 Prints (previews) the detailed report for the current strip. See chapter 10 for 
more information on reporting.

	 Shows or hides the sample information panel.

Reporting Toolbar
See chapter 10 for a detailed description of the toolbar buttons.

	 Navigate sheets.

	 Clear all sample information from all strips on the selected sheet.
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	 Advanced sample editing controls. See chapter 8 for more information on 
managing sample information.

	 Shows the Report Settings dialog (see chapter 10) or the Program Settings 
dialog (see chapter 4 and chapter 11).

Strip Calculator Toolbar
See chapter 12 for a detailed description of the toolbar buttons.

	 Click to select a different assay type.

	 Controls the display (zoom level) of the strip schematic.

	 Copies the currently displayed strip schematic to the clipboard.

	 Copies the currently displayed result text to the clipboard.

StripAssay Selector Toolbar
See chapter 13 for a detailed description of the toolbar buttons.

	 Set the display style and sort order of assay definitions.

	 Turns management mode on or off.
	 Opens the Strip Calculator window with the currently selected assay type 

preloaded.

	 Shows or hides the strip preview.

Print Preview Toolbar
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See chapter 10 for additional information on reporting.

	 Prints the report.

	 Controls the zoom level.

	 Navigates the pages of the report.

	 Closes the Print Preview dialog.
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